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Welcome to the latest revisions to Australia's BullCharts charting 
software — version 4.0.  This version runs on Windows XP, Windows 7 and 
Windows 8 (both 32-bit and 64-bit).

Whilst at first glance this new version of BullCharts looks basically the same as the 
previous version 3.9, there are no less than 40 changes, updates or 
enhancements.  A number of these are significant changes — some of which will 
be readily apparent to regular users and intraday users, with other changes not so 
obvious.

Just some of the major new features
include:

• Detailed Watchlist

• Market Depth revisions 
(for Windows 7 and above)

• New “report” window pane to
display key stock data.

This document provides an overview of
all the changes in this new Version 4.0.
Also refer to past “What's New”
documents for a list of the changes in
other recent versions.

BullCharts staff

BullCharts support:
email: info@bullsystems.com.au 
phone: 02 9495 8400

Printed: 8 Aug 14 (revision 4)

Market Depth
vertical bar chart

Detailed watchlist

Report window

mailto:info@bullsystems.com.au


What's New in BullCharts version 4.0

Table of Contents

General......................................................................................................................3
Arrow heads on the Line Interval tool..............................................................................3
Price movement values in tooltip box..............................................................................3
Edit Undo function...........................................................................................................4
Cross-hair cursor — colours improved............................................................................4
Clear data cache.............................................................................................................4
Weekly bar now always shown on Monday.....................................................................4
Space to right of chart — settable for each security........................................................4
Price Info Window — now has customisable properties..................................................5
Quarterly chart tooltip revision........................................................................................6
Refresh the indicator & scan lists without restart.............................................................6
Intraday data — storing intraday chart data for longer....................................................7

Watchlist enhancements............................................................................................8
Colour the watchlist entries & new hotkeys.....................................................................8
Using and sorting the "Comment" field in watchlists........................................................9
NewsWatch — news for all stocks in a watchlist.............................................................9
Detailed Watchlist — price details.................................................................................10

Dynamic Market Depth — bar charts......................................................................11
Market Depth in Windows XP.......................................................................................11
Market Depth in Windows 7 and 8................................................................................11
Expand/collapse depth details......................................................................................12
Market Depth — horizontal bar chart............................................................................12
Market Depth — vertical bar chart.................................................................................13
Indicative price levels during Pre-Open.........................................................................14
Indicative price levels during the 4pm match-out..........................................................15

Alerts (on price and volume)....................................................................................16
Description column displayed in Alert Summary window..............................................16
Use BullCharts while Alert Scan runs............................................................................16

BullScan — enhancements.....................................................................................17
Scan Rejects — including scan results data.................................................................17
Auto-export the scan results to CSV.............................................................................17
Copy the Scan Date vertical line to other chart windows...............................................18

Chart indicators — new and updated......................................................................19
Ex-Dividend Date — vertical line...................................................................................19
Save default settings for indicator Markers...................................................................19
Indicator ribbon height — adjustable.............................................................................20
Fundamental Data (indicator) report.............................................................................20
Auto-insert date in indicator using cursor date..............................................................21
Heikin-Ashi candlesticks — enhanced colour codes.....................................................21
Double Top & Bottom chart patterns.............................................................................22
Ichimoku indicator — displays accurate cloud...............................................................22

BullScript enhancements.........................................................................................23
Candlemode linestyle — controlling candle colours......................................................23
Report window and report attribute...............................................................................23
Fundamental Report attributes — explained.................................................................24
New indicator Markers in BullScript...............................................................................26

Bug fixes and minor changes..................................................................................27
EOD data download information display.......................................................................27
Dilution factor problem..................................................................................................27
BullScript scans and the future function........................................................................27
Holidays on intraday charts...........................................................................................27
Splash page information on start up..............................................................................27
Swedish decimal point fixed..........................................................................................27

Page 2 of 27 Printed: 8 Aug 14 (rev 4)



What's New in BullCharts version 4.0

General
This section describes a number of the general changes and enhancements to BullCharts.

Arrow heads on the Line Interval tool 
The standard Line Interval drawing tool now has additional style features added.  An 
arrow head can be applied to one or both ends, and the arrow head size can be adjusted.

To add a line interval with arrow head(s) to the chart::-

• Apply a line interval to the chart as normal.

• Double click on the line to open “Trendline Properties” (or right-click on the item on 
the chart and select “Trendline Properties” from the drop-down menu).

• Under Arrow section, make the required changes.

Price movement values in tooltip box
When hovering the mouse cursor over a price chart, a
chart tooltip is displayed (see screen shot).  This tooltip
shows some price data for the date in question.  One
extra data item has been added to this tooltip to indicate
the Movement in price in this period.  If looking at a daily
chart, then the data refers to the movement in price for
that day (likewise for a weekly chart, etc.).  The two
values are the dollar amount, and the percentage
amount.  On an index chart, the movement is simply in
index points.

Note: You need to hover the mouse cursor directly over
a price bar or candle, or over the line if using a line chart.

Note: If you cannot see tooltips when hovering the mouse cursor over the price, it may be 
turned off in the Tools Preferences section.  
Refer to the menu option: Tools > Preferences > “Show chart tooltips when moving 
mouse over it”.
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Edit Undo function
As with many software packages, when making
changes to a document, or spreadsheet, or
whatever, it is usually possible to “undo” the latest
change.  This is now also possible in BullCharts.  

For instance, you might have accidentally deleted
some trend lines, or comment, or other chart tool
from your price chart.  Simply use the menu item: 
Edit > Undo, or use the function key sequence: 
Ctrl+Z (ie. the Control key and the letter z).

Cross-hair cursor — colours improved
When using the cross-hair cursor, the price value is
indicated on the right axis, and the date value on the time
axis.  Some users found it difficult to read these values.
The contrast between the text and the background for
these have been improved — black text on light grey
background.  The price “tag” on the right hand axis is
unchanged (still white text on black background).

Note: You can enable the cross-hair cursor using the
menu option: View > Crosshair, or using the shortcut
key combination: Ctrl+Shift+X.

Clear data cache
There might be an occasion where the chart looks
a little strange due to the data that is held in the
BullCharts cache (eg. for foreign stocks/indexes).
This option will clear the cache for the currently
viewed security.  Access it by right-clicking on the
price chart, and select the option from the drop-
down menu.  If this option is not visible in the drop-
down menu, then there is no relevant cache data.

Weekly bar now always shown on Monday
In the past, whenever Monday was a holiday, the relevant bar on the weekly chart was 
displayed a little offset.  This is now fixed so that the week always starts on Monday, and 
the weekly bars are always evenly spaced.

Space to right of chart — settable for each security
It is now possible to automatically store the amount of space to the right of the chart for 
each individual security.  This option is available in the IntelliCharts settings from menu 
option: Tools > Preferences > IntelliCharts > Save Time Axis Settings (for each 
security).
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Price Info Window — now has customisable properties
The Price Info Window information panel can be opened to display the price and volume 
values, and the values of any displayed indicators.  This Info Window tool now has 
properties that can be adjusted by the user (see screen shot below for details).  To 
access the properties dialogue box, first display the Price Info Window panel*, then right-
click near the middle of the Info Window and choose Info Window Properties from the 
drop-down menu.  The property options (shown in the screen shot below) include:

• Use plot colours or not  — If this is turned off, then all items in the Price Info 
Window list will be in black.  If turned on (to use the plot colours), then any colours
that have been applied to indicators on the chart will also be used for the 
corresponding entry in the Info Window list.

• Use abbreviations or not — If enabled, this will display additional information for 
the entries in the info list.

• Set right alignment in Value column — The item values shown in the right hand 
column of the Info Window can be shown left-aligned or right-aligned (in the sample
they are left-aligned).  One of these might be useful for some information items, 
while the other might be useful for other items.  For example, the volume (if 
displayed) could be a very large number compared to the price, or the indicator 
values.  This option will set the right-alignment either on or off.

Also note that the Price Info Window can be re-sized by dragging any edge up, down or 
sideways.

* — To display (or hide) the Price Info Window
panel, either use the menu options: 
View > Panels > Price Info Window, or use the
toolbar button (see screen shot at right).
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Quarterly chart tooltip revision
When hovering the mouse cursor over a quarterly
price chart, the tooltip now displays the last month
of the quarter — March, June, September or
December.  This is in keeping with the standard
quarterly notations where people say, for example,
“for the June quarter”, referring to the quarter that
ends in June.

The sample shown at right indicates that the
quarterly candle shown above the month “April” on
the time axis corresponds to the quarter than ends
in June.

Refresh the indicator & scan lists
without restart
It is important to understand that each of the BullCharts scans and indicators (as well as 
the templates and watchlists etc.) are stored as discrete files on the computer's disk, 
outside the BullCharts software environment.  It is possible to manually manipulate these 
files, and copy or delete them to/from the disk.  You can add additional ones using 
Windows Explorer outside of BullCharts, or you can save an additional scan or indicator 
file that is downloaded, or received by email.  [To see which directories these items are 
stored in, use the BullCharts menu option: Tools > Preferences > Files (tab).] 

When the BullCharts program starts running, it looks in the relevant directories on the disk 
to see which scan files and indicator files are available to it.  BullCharts stores a list of 
these internally for quick display in the appropriate pane in the Control Panel (eg. in the 
BullScan Manager pane).  Once running, BullCharts does not re-check to see what files 
are currently available in these directories.  If you add an additional scan file or indicator 
file to the directory, then they won't be displayed in the Control Panel.  

In the past, making changes to these files outside of BullCharts meant having to close 
BullCharts and start it again so it would read the directory listing again.

This version of BullCharts now includes a “Refresh” option to get BullCharts to refresh it's 
internal list of the Custom
Scan files and Custom
Indicator files.  The
screen shot at right
shows the Refresh button
on the “Scan” tab; but
there is a similar button
on the “Indicators” tab.

This refresh will only
“add” missing items to the
lists.  It will not remove
items that have been
manually deleted from
disk. 

Note: Both the 
Workspaces and 
Watchlists already have
a Refresh option (right-
click on each in the 
Security Manager).
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Intraday data — storing intraday chart data for longer
It is now possible to keep intraday (minute) charts for up to 65 days, using the option in 
BullTools.  (NOTE: The BullTools feature is to be used with much caution.)

Note: To be able to retain and display this intraday chart data, it is necessary to display the
data in order to have the data downloaded and stored in your local cache.  Then it can be 
retained for the period specified.  Also note that “clearing the cache” for a security will also 
clear the intraday data.
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Watchlist enhancements
There are several enhancements to the watchlists feature, including two significant ones:

• NewsWatch — a summary list of recent news for all stocks in one watchlist.

• Detailed  Watchlist — for a more detailed view of the stocks in a watchlist 
(including price data).

Colour the watchlist entries 
& new hotkeys
The coloured watchlist entries feature was added
in an earlier version.  For entries in a watchlist, the
entries can be assigned one of six colours.  See
example in first screen shot at right.

To apply a colour to a watchlist entry, right-click on
the watchlist entry and choose the “Select
Colour” option from the drop-down menu.

Hotkeys for coloured entries

With Version 4.0 of BullCharts, hot keys
have been assigned to these colours so
that a colour can be applied to a watchlist
entry using the hotkey, instead of having to
right-click and select from the drop-down
menu.

The hotkeys utilise the Control key on the
keyboard, in conjunction with a numeric
key.  To apply a colour to a watchlist entry,
click once on the watchlist item to “select it”
(or navigate to it in a watchlist using the key
board arrow keys), then simply hold down
the Control key and tap the desired number
keyboard key.  Note that the keys on the
numeric keypad do not have any effect — it
is the row of number keys across the top of
the keyboard from 1 to 7.  The number one
key will remove any applied colour.

Changing the default colours

To change the default colours, first left-click
on the “Watchlists” item in the Security
Manager window (see the second screen
shot at right), then right-click on this item and
select “Properties” from the drop-down menu.
Then select the “Sort Order” tab.
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Using and sorting the "Comment" field in watchlists
The watchlists feature in BullCharts
had an additional column included in a
recent version — to display a text 
Comment that you might want to
associate with a particular entry in a
particular watchlist.

A minor change with version 4 enables
you to sort the watchlist by the
information in the “Comment” column.
Either right-click on the watchlist and
choose “Sort by Comment” from the
drop-down menu (as indicated in the
screen shot at right), or click on the
column header itself (on the word
“Comment” in the column header), and
a small triangle will indicate the sort
sequence — ascending or descending.
Click on this a second time to reverse
the sort sequence (this also applies to
things like the columns in the Scan Results Table after a running a scan).

NewsWatch — news for all stocks in a watchlist
The NewsWatch feature
displays a new window pane
with a list of recent company
announcements for all stocks in
any one watchlist, as shown in
the screenshot below.  In this
sample, the Watchlist name is
shown in the title bar of the
window: 
“5 Day Price Increase by More
Than 10% (Rejects)”.  If the
window pane is maximised,
then this will not appear.

There are two ways to generate
this NewsWatch list:

1. Right-click on any
watchlist and from the
drop-down menu select:
"View NewsWatch"; or

2. View the contents of the
desired watchlist (click
once on the watchlist to
“select” it), then click on the
Security Manager toolbar
button (as shown in adjacent
screen shot).
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Detailed Watchlist — price details 
The Detailed Watchlist feature will display a new window pane, relevant to all stocks in any
one watchlist.  For live data users the information displayed is a dynamically refreshing list 
of key price data as shown in the screen shot below.  Clicking on any column heading will 
sort the list by the contents of that column.

There are three ways to generate this Detailed Watchlist:

• Double-click on a watchlist in the Security Manager; or

• Right-click on any watchlist and from the drop-down menu select: "View Detailed 
Watchlist"; or

• View the contents of the desired watchlist
(click once on the watchlist to “select” it), then
click on the Security Manager “View Detailed
Watchlist” toolbar button (as shown in adjacent
screen shot).

Detailed Watchlist — EOD data plan

For users on the EOD data plan, the Detailed Watchlist option will display as in the screen 
shot below.

Detailed Watchlist properties

The Detailed Watchlist window
pane is customisable.

The screen shot at right shows the
drop-down menu (right click any
where on the window pane).
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Dynamic Market Depth — bar charts
The Market Depth facility and screen(s) (for live data subscribers) have been updated for 
later versions of Windows (ie. Windows 7 onwards). This is not available in Windows XP.  
For Windows XP, the existing market depth screen is unchanged, and none of the 
following applies.

Market Depth in Windows XP 
The Windows XP version is unchanged and continues to display the market depth table as
in the screen shot below.  Note that both a “Summary” view and a “Details” view are 
available.  A “Depth Chart” version (horizontal bar chart) is also available.  It is also 
possible to display either 5, 10 or 25 depth levels (only 5 levels are displayed in this screen
shot).  Note that every second bar is shaded to aid readability.  Hovering the mouse cursor
over one buy or sell price level shows the relevant cumulative quantity.

Market Depth in Windows 7 and 8
The Windows 7 equivalent of the above is shown in the screen shot below.  Note the two 
“Chart” options: Horizontal, and Vertical.  Also the four different Depth Levels — 5, 10, 25, 
and 50.  Note that every second bar is shaded to aid readability.

Page 11 of 27 Printed: 8 Aug 14 (rev 4)



What's New in BullCharts version 4.0

Expand/collapse depth details
The first thing to spot in the revised (Windows 7,
8) market depth screen are the expand/collapse
indicators down the left edge and the right edge
of the window pane, as in the adjacent screen
shot.

In this example, a number of sellers are offering
quantities of stock for sale at the ask price of
$81.94, $81.95, $81.96, etc.

The column headed “#S” indicates the number
of sellers offering stock at each price level.  The
sample shows 8 sellers offering at $81.94.  By
clicking on the [+] symbol to expand the list, or
the [-] symbol to collapse the list, we can view or
hide the quantities offered for sale by each seller.

Market Depth — horizontal bar chart
The screen shot below is the same as the Windows 7 version above, except that the 
“Chart — Horizontal” option is ticked.  This displays horizontal coloured bars to indicate the
total quantities at each price level.

In this screen shot, note the [+] symbols on some lines, which indicate that information 
shown at that price level is a summary version, showing the aggregated volume for the 
bids, or the asks, at that price level.  Clicking on this [+] symbol will expand to show all the 
market participants at that price level.
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Market Depth — vertical bar chart
The special screen shot below shows the dynamic market depth chart with both the 
horizontal bars, and vertical bars, options enabled.  It also includes a candlestick chart to 
the left, showing two full daily candles.  This image was captured in the early morning 
before trading for the day.  There are several useful observations from this image.

1. The candle chart to the left includes the complete daily candle for 14 July.

2. The single vertical line down the market depth (vertical bars) indicates the last 
traded price ($37.750).  In this example before trading opens for the day, it is the 
close price the previous day (compare to the candle chart).  During the trading 
session, this vertical line is the very last traded price.

3. The lightly shaded grey area running down the vertical bar chart portion of the 
market depth indicates the price range.  Again in this example it is for the previous
day, and it's extremes match the values on the candlestick chart — Low $37.61 
and High $37.77.  During a trading session, this shaded area indicates the high and
low for the current trading session.

4. The vertical bars indicate the volume at each price level.

5. By hovering the mouse cursor over one of the vertical volume bars, a pop-up 
window displays all the individual orders sitting in the market at that price point.  In 
this case, with the cursor sitting on the vertical bar at the $37.78 price level, the 
twelve sell orders are shown, for a total of 8,079 shares.
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Indicative price levels during Pre-Open
During the market pre-open phase (the lead up to the 10am open), the price labels in the 
market depth screen can change colour to indicate indicative pricing (see example in the 
screen shot below).

• When the indicative price is greater than 0, the price label turns yellow to indicate 
that it is the indicative price. 

• On the Buy side, if any bid prices are greater than or equal to the indicative price, 
they turn yellow to indicate “Indicative” depth levels.

• On the Sell side, if any ask price is less than or equal to the indicative price, they 
turn yellow to indicate “Indicative” depth levels.
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Indicative price levels during the 4pm match-out
Similar to the Pre-Open above, the 4pm match-out that takes place at 4:10pm utilises the 
yellow colouring of the horizontal bars as shown in the screen shot below.  The first image 
shows the market depth just before 4:10pm, with the orders to be matched indicated in 
yellow.  The second image shows the same screen a short while later, after the 4:10pm 
match-out, with a number of orders matched.  Of course, this display automatically 
refreshes during the 10 minute period as more orders enter the market, or some are 
removed.
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Alerts (on price and volume)
The Alerts feature has been included in BullCharts for some time, and the “Alert Trend 
line” (a sloping alert line for price or volume) was included recently.  There is now an 
additional enhancement to the Alerts feature.  

Note that the Alerts feature includes: Alert Summary window (in the Control Panel), and 
the Alert History window and Alert Manager window from the menu options.

Description column displayed in Alert Summary window
When creating, or adjusting, an alert there is a “Description” field in which some text can 
be entered for future reference.  This text
description is now displayed in the Alert
Summary window pane (in the Control
Panel).

Use BullCharts while Alert Scan runs
Depending on the number of alerts that are set, and the speed of the computer, the Alert 
Scan can take quite some time.  While the Alert Scan is running it is now possible to 
continue using other BullCharts features without having to wait for the Alert Scan to finish.
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BullScan — enhancements
Some key changes have been made to the BullScan feature as follows.

Scan Rejects — including scan results data
When a BullCharts
scan runs, the Scan
Results Table has had
two tabs — the “Scan
Results” tab, and the
“Rejects” tab.

The Rejects tab lists
all the securities that
were rejected based
on scan criteria, or
dates, etc., and the
Reason for Rejection.

This list of rejects now
also includes the
same columns as the
“Scan Results” table.

In addition to this, you
can right-click on the
list and a number of menu options are available from the drop-down menu.

Auto-export the scan results to CSV
The results of a scan can now be automatically exported as a CSV file.  The export 
location is the folder: C:\Program Files\BullSystems\BullCharts\export.  (This folder 
location is adjacent to the Custom Scans, Indicators, Templates, etc. folders.  You can find
these using the menu option: Tools > Preferences > Files (tab).).
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Copy the Scan Date vertical line to other chart windows
After running a BullCharts scan, and viewing
the Scan Results Table, you can double-click
on a security in the table to produce a price
chart of the stock.  The chart will
automatically include any indicators that were
quoted in the scan criteria.

Now you can right-click on the Scan Date
vertical line, and from the drop-down menu
select “Copy”, then on another price chart
window right-click and “Paste” to have this
chart element replicated onto the second
window on the correct date.
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Chart indicators — new and updated
There are several new (or revised) standard indicators now included in the “Indicators” 
folder.  Remember that any custom indicators are stored in a separate folder (find the 
folder location using the menu option: Tools > Preferences > Files).  The indicator files 
are of the type “bss” (eg. filename Heikin-Ashi.bss).

The new or revised indicators are listed here with more details below.

• Ex-Dividend Date Vertical Line;

• Save default settings for indicator Markers;

• Indicator ribbon pane height is adjustable;

• Fundamental Data (indicator) report.

• Auto-insert date in indicator using cursor date;

• Heikin-Ashi revisions;

• Double Tops and Double Bottoms indicator;

• Ichimoku indicator — the cloud correctly projects forward;

Ex-Dividend Date — vertical line
This new chart indicator places
a vertical line on the chart at the
current ex-dividend date —
regardless of whether the date
is past, or future.  Note that the
“current” ex-dividend date will
be the latest one that has been
notified, and many companies
don't advertise their ex-dividend
date until rather close to the
actual date.

Key style features of the vertical
line are customisable (solid,
dashed or dotted, and colour).  

This is classified as an indicator
even though the result is a
single vertical line down the
chart.

Save default settings for indicator Markers
When customising the markers on indicators, it is now possible to also save the changed 
markers as the default settings.
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Indicator ribbon height — adjustable
One key feature of BullCharts is the
collection of indicator ribbons that
can be placed across the chart
(either at the bottom or the top).
[To see a list of all available
indicator ribbons, choose the menu
option Insert > Indicator, and
under the “Category” drop-down
choose “All Ribbons”.]  The height
of all of these ribbons can now be
adjusted.

The value for ribbon pane height
can be changed down to 5, or up to
a maximum of 50.  A smaller value
will enable more information to be
displayed and more easily viewed
on screen.

From the menu option Tools >
Preferences > Indicators (tab),
note the new option as shown in
the adjacent screen shot.

Fundamental Data (indicator) report
There are up to about 20 fundamental data items stored in the BullCharts database for 
each security.  These can be used in scan criteria, and in custom BullScript.  The same 
data items can also be displayed in a
pop-up window that can be positioned
anywhere around the screen, or moved
to another monitor.

For a detailed list of the possible
attributes that can be used to refer to
the fundamental data values shown in
this report, see the section
“Fundamental Report attributes — 
explained“, on page 24 below.
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Auto-insert date in indicator using cursor date
There are some chart indicators in BullCharts that have a date as an input parameter.  A 
number of these are categorised as “Stop Loss” type indicators.  With some of these 
indicators, the date parameter is intended to be the start of the latest uptrend, which can 
vary from stock to
stock, and from time
to time.  So it is
useful to be able to
automatically enter a
date, rather than
type it in every time
you insert the
indicator.  A good
example of this is
shown in the price
chart at right.

Now you can set the
date automatically
as follows.

When viewing a
price chart, and you
want to insert an 
indicator on the
price chart, simply
right-click at a point
along the chart at
the date that is to be
used as the input
parameter in the 
indicator.  In the
sample chart shown
above, right-click on
the date 6th June,
and choose Insert
Indicator from the drop down menu.  This date is then automatically entered as the 
required date, as shown in the next screen shot above.

Heikin-Ashi candlesticks — enhanced colour codes
The underlying script code that defines the Heikin-Ashi candles indicator has been 
updated so that the user can now change the candle colours in the BullScript code (using 
the Indicator Builder feature).

Previously, this indicator included the linestyle statement:

[linestyle=candle]

Now, this statement has additional parameters.  The format of the revised statement is:

[linestyle=candle; candlemode=3; color=black; color2=green; 
color3=red;]

For an explanation of these parameters, see the section “Candlemode linestyle — 
controlling candle colours” on page 23 below. 
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Double Top & Bottom chart patterns
This new indicator looks for two extremes of price on the chart (ie. peaks and troughs) at 
about the same price level over a time period.  If it finds price movements that could 
potentially be classified as a Double Top chart pattern, or Double Bottom chart pattern, 
then the price peaks (or troughs) are flagged on the chart.  An amount of interpretation and
discretion is required with the results.  See sample screen shot.

Ichimoku indicator — displays accurate cloud
The Ichimoku indicator has been updated to correctly offset the cloud (First/Second 
Senkou span) forward by 26 bars.  [The indicator has been updated to achieve this using 
the hozshift function in BullScript.]

Page 22 of 27 Printed: 8 Aug 14 (rev 4)



What's New in BullCharts version 4.0

BullScript enhancements
A number of enhancements have been made to BullScript as follows.

Candlemode linestyle — controlling candle colours
The linestyle type “candle” now has the parameter: candlemode.  This is explained as
follows:

[linestyle=candle; candlemode=3; color=black; color2=green; 
color3=red;]

Where each element is explained as follows:

candlemode=0 — Applies just one colour to the candles (and white).  The candle 
body outline colour, and any applied fill colour, will be just one colour as 
specified with the  color=  parameter.  In the example above, this is 
specified as 
“color=black;” and so the body outline and any fill colour will be 
black.

candlemode=1 — This mode utilises three colours, which are applied based on 
the price change since previous.

candlemode=2 — This mode utilises three colours, which are applied based on 
the price change since open.

candlemode=3 —  This mode utilises three colours, which are applied based on: 
High, Lower Trend.

Report window and report attribute
When an indicator contains the report attribute, the indicator will open an indicator 
report window which can display the latest values for the indicator results, or the security 
details.  An example of this is the Fundamental Report indicator (mentioned in the section
“Fundamental Data (indicator) report” on page 20 above). 

This new feature is actually rather
significant.  For example, you might
want to step through the stocks in your
watchlist, and not only view the price
chart, but also see some key items
like: last close price, EPS, PE, Market
Cap and the Ex-Dividend Date (as in
the screen shot at right).

This Report attribute now enables this.

This new feature is now implemented
in the new Fundamental Data report.
More details about the script
implementation of this are included in
the next section below.

Key points to note:

1. All pre-defined variables and
user's variables need to be in
the format:  

<<variable_name>>

2. User's variables need to be defined as follows (for example):
 [name=YourVariableName]
 H-L;

Page 23 of 27 Printed: 8 Aug 14 (rev 4)



What's New in BullCharts version 4.0

Fundamental Report attributes — explained
The script shown in the box below is the complete content of the (new) Fundamental Data 
Report indicator.  To explain the content, consider the following explanation looking at just 
some of the statements from that script:  The complete listing for the Fundamental Report 
is shown on the next page to indicate the valid values.

Ref Explanation for each statement

1
[name=LastPrice]

This statement specifies the name for the 
“plot” that is defined in the following lines.  
We are naming this plot: “LastPrice”.  Also, 
this text is stored within the variable that is 
called “name”.

2 c
;

Entering the letter “c” here (representing the
close price), tells BullCharts to generate a 
plot of the close price.
followed by a semi-colon character.

3 [report="<<name>>";
reportcontents="

This specifies that the following portions of 
the script are specifying a “report”, where 
the title of the report is in the variable that 
we declared above, called “name”.  This will
appear in the title bar of the report that will 
be displayed on screen.
The contents of the report follow, starting 
with the double quotes “ character which 
appear at the end of this line.  This double 
quote character is the opening quote and 
will have a closing quote at the end.

4 <<security.ExDate>>
<<security.TotalIssue>>

These are two script variables whose 
values are available for reference within the
script code. These two lines simply state to 
display their values.

5 (several statements have been omitted 
here)

6 <<security.IndustryGroup>>
<<security.SectorIndex>>

The same comment as above for script 
variables (in ref 4).

7 ;
"]

This semi-colon character indicates the end
of the list of items, and is the instruction to 
“plot” or “display” the items above.
The double quotes character “ is the closing
quote that completes the pair (for the quote 
that was entered above at ref 3), followed 
by the right hand square bracket which 
completes the specification for the “report” 
that was commenced above.
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The graphic below is the complete BullScript code for the new Fundamental Data 
(indicator) report.  Note the use of the variables to refer to the various fundamental data 
items.  

Fundamental Data report — the complete script

[name=LastPrice]
c;

[report="<<name>>";reportcontents="
<<LastPrice>>
<<security.TotalIssue>>
<<security.AssetBacking>>
<<security.NetTangibleAssets>>
<<security.EarningsPerShare>>
<<security.DividendPerShare>>
<<security.CurrentDividendAmount>>
<<security.FrankedPercent>>
<<security.GrossDividendAmount>>
<<security.AnnualDividendPerShare>>
<<security.MarketCap>>
<<security.EarningsYield>>
<<security.PERatio>>
<<security.DividendYield>>
<<security.DividendCover>>
<<security.ExDate>>
<<security.DividendPayableDate>>
<<security.IndustryCode>>
<<security.Sector>>
<<security.IndustryGroup>>
<<security.SectorIndex>>
;
"]

To create a customised version of this with a lot fewer items displayed, simply use the 
Indicator Builder function to firstly copy this indicator, then edit the copy and simply remove
the lines that are not required.
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New indicator Markers in BullScript
Markers can be drawn on indicators such as the cross-over points in the Moving Average 
Cross-over indicator (shown in the screen
shot below right).  Sample script to do this
(in this indicator) is shown below:

{ Markers }
[name=Above; linestyle=marker; 
marker=type1; tooltip="Short MA
passed above Long MA"]
if (n1<n2, cross(res1,res2), 
cross(res2,res1));

[name=Below; linestyle=marker; 
marker=type2; tooltip="Short MA
passed below Long MA"]
if (n1<n2, cross(res2,res1), 
cross(res1,res2));

This script in this particular indicator
results in the price chart shown in the
accompanying screen shot.  Note that the
script that produces this marker with the
text “Above” and the marker “icon” of the
number “1” is: “marker=type1”.  

Additional marker icons can now be drawn
on the price chart using the relevant “type”
from the table below.  The colours of each
icon can be changed as with other on screen items.

The “marker” icons in BullCharts and available in BullScript

type0 type7 type15 type22

type1 type8 type16 type23

type2 type9 type17 type24

type3 type10 type18 type25

type4 type11 type19 type26

type5 type12 type20 type27

type6 type13 type21 type28

type14 type29
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Bug fixes and minor changes
Several bug fixes and very minor changes have been made as follows.

EOD data download information display
When downloading End of Day data for several days, the informational window pane used 
to list all of the days for which data was downloaded and could run from the top to the 
bottom of the screen.  Now the information display only provides a summary, and the 
informational message that it completed.

Dilution factor problem
When a security symbol is changed, and the dilution factor = 1, BullCharts now ignores the
data.

BullScript scans and the future function
BullCharts could not scan BullScript that contained a future function.  Now resolved.

Holidays on intraday charts
Changes have been made so as to not display holidays on intraday charts.

Splash page information on start up
When the BullCharts program
starts up, depending on the
speed of the computer, it can
take a short while to load lists
of available indicators, scans,
watchlists, etc, into memory
for quick access later.  The
new splash page that is
displayed on start up now
includes small informational
messages (in the lower left
corner) to indicate the
progress during the software
loading process, so the user
won't wonder if anything is
actually happening.

Swedish decimal point fixed
The Swedish decimal point issue (a comma instead of a decimal point dot) on alerts has 
been fixed.
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